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About this manual
1  About this  manual

The Busy Lamp Field program BLF-Win displays the ringing states of the configured 
subscribers and subscriber groups. 
BLF-Win works in conjunction with AC-Win SL and DS-Win V4:
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Features and overview of BLF-Win
1.1  Features and overview of BLF-Win

• User interface

– Color-coded status display

– Phone States: Idle, Ringing, Busy, Out of service, Does not exist

– Option of displaying station numbers or names

– Display of different index cards (for example, for a number of departments)

– Customized configuration and design of the program window.

• Display of up to 1000 subscribers permitted

– Individual telephones (for example, executive telephones), subscriber ranges (for 
example, agents)

– Note function provided when subscribers and subscriber ranges are created. The 
note appears in the fast tip.

• Integrated work flow with other applications

– Interfaces to AC-Win (attendant console) and DS-Win (directory services)

– Interface to Outlook Exchange

– Switching function available by clicking the station number field

– Call forwarding feature can be enabled

– Status displays provided when the search function is selected in the DS-Win task 
bar. 

NOTE:  Hunt groups are not supported in BLF-Win. 
 A31003-H3231-U100-01-7619, 10/2022
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About this manual
1.2  Benefits of this program to the customer

• Extensive information about switching using subscriber states and the consequent 
avoidance of unsuccessful switching operations

• Reliable information display during incoming calls regarding the connection request

• Shorter switching times and a consequent increase in productivity

• Secure place in future markets through the use of a standard platform and integration 
in Unify applications

• Flexibility provided by the LAN design

• Integrated in the Unify service infrastructure
A31003-H3231-U100-01-7619, 10/2022
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Starting the program
1.3  Starting the program

BLF-Win Client is designed for continuous operation and is usually started by the system 
user or administrator. 

Follow the steps below to start the BLF-Win Client:

1. Click on Windows Start menu and search for BLF-Win.

2. Double-click on the BLF Client icon.

3. The main window appears after you have started the BLF Client.

For the description of BLF Server, refer to the BLF-Win Service Documentation.
 A31003-H3231-U100-01-7619, 10/2022
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The main window
2  The main window

This chapter describes the structure of the BLF-Win program.

The main window contains the following components:

• the title bar 

• the menu bar 

• the index cards

• the display panel with:

– the subscriber

– the subscriber ranges

• the legend

• the connection status
A31003-H3231-U100-01-7619, 10/2022
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Title bar
2.1  Title bar

The title bar is located at the top of the main window. It contains:

• the program names

• the status of the connection with the OpenScape 4000

• the name of the currently open file

Not connected status

The figure below illustrates BLF-Win-Client in "disconnected" status. All extensions are 
displayed in gray, which means that they are out of service.
 A31003-H3231-U100-01-7619, 10/2022
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The main window
Connected status

The subscribers are displayed using the various color-coded status options in the 
connected status.

2.2  Menu bar

The menu bar is located underneath the title bar in the main window and displays the 
following drop-down menus.

The functions of the drop-down menus are described in Chapter 3, “Using BLF-Win”.

2.3  Display panel

The telephone calls conducted by the subscribers and subscriber ranges are displayed in 
the display panel using different colors. The color used depends on the current status of the 
call. 

You can customize the display panel by right-clicking in the relevant fields.
A31003-H3231-U100-01-7619, 10/2022
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Display panel
2.3.1  Index cards

The index cards are located underneath the menu bar in the main window.

You can find out how to create new index cards or edit/delete existing ones in Chapter 3.3, 
“Editing index cards”.

2.3.2  Subscriber range

Subscribers from the same department can be grouped into subscriber ranges. The 
subscriber range or ranges configured are displayed in the display panel. A subscriber 
range can contain up to 10 subscribers.

You can find out to how to create a new subscriber range or edit an existing one in Chapter 
4.2, “Managing subscriber ranges”.
 A31003-H3231-U100-01-7619, 10/2022
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The main window
2.3.3  Subscriber

The station numbers/names are displayed in table form in the display panel.

NOTE:  A fast tip indicating the name of the subscriber, a short note, the subscriber’s status 
(phone icon) and the presence status (calendar icon) if you position the pointer over a 
subscriber.

You can also configure the display panel to display the names of the subscribers (Chapter 
3.5.3, “Displaying names”).

The connection states of the subscribers are displayed in different colors.

You can change the color settings as required (Chapter 3.5.14, “Defining colors”).

According to your requirements, you can use drag-and-drop to arrange the subscribers and 
the subscriber ranges in the display panel.

The subscriber is idle. The subscriber can receive a 
call or initiate a call at any time.

The subscriber is receiving a call or is making a call. 
The subscriber's telephone or the call party's 
telephone rings but a connection is not set up yet.

The subscriber is dialing a calling number (dialing 
state) or currently conducting a call (talking state).

The subscriber is configured in OpenScape 4000 but 
is not connected to the OpenScape 4000. The 
subscriber cannot make a call or receive a call. 

The subscriber is not configured in the OpenScape 
4000.
A31003-H3231-U100-01-7619, 10/2022
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Display panel
NOTE:

While in busy state, you can see if the call is either external or internal. In case of an external 
call, either incoming or outgoing, an additional icon (e.g. arrow) will be shown under the 
subscriber’s number/name.

This arrow is only displayed while a subscriber is in busy state. For internal calls, the default 
busy status will be displayed, i.e. without the arrow. The fast tip is also updated with a hint 
that the call is external.
 A31003-H3231-U100-01-7619, 10/2022
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Using BLF-Win
3  Using BLF-Win

This chapter describes the different functions and commands of BLF-Win.

The menu bar is located under the title bar in the main window. 

The figure below displays all menu options contained in the drop-down menus in the menu 
bar: 

A dialog box usually opens when you click a menu option. The dialog box entries have the 
following meaning:

The entries should take effect.

The entries are applied, but not saved.

The predefined settings will be loaded and will take 
effect.

The process is canceled. The settings will be reset to 
their former state. 
A31003-H3231-U100-01-7619, 10/2022
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Configuring BLF-Win
3.1  Configuring BLF-Win

The File drop-down menu contains functions that allow the user to configure the display 
panel. 

The following functions can be executed:

NOTE:  The Save and Save as... menu options can only be selected if you have entered 
the correct password under Tools / User / Administrator mode in the menu bar.

Create a new configuration

Save a configuration

Save a configuration under a different name

Open a saved configuration 

Exit BLF-Win Client

Table 1 Functions for configuring the display panel
 A31003-H3231-U100-01-7619, 10/2022
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Using BLF-Win
3.1.1  Creating a new configuration

You can use this menu option to create new configuration files.

All index cards, subscribers and subscriber ranges are deleted from the user interface when 
you create a new configuration.

To create a new configuration open the File menu and click New. A new blank display panel 
opens.
A31003-H3231-U100-01-7619, 10/2022
BLF-Win 3.0, User manual 17



Exiting BLF-Win
3.1.2  Opening a saved configuration

This menu option opens an existing configuration.

1. Open the File menu and click Open.

2. Enter the name and directory of the configuration file or select a name from the list. The 
selected configuration file opens.

3.1.3  Saving a configuration 

The Save menu option is used if you want to save the current configuration. 

1. Open the File menu and click Save.

The file is saved. 

NOTE:  The Save and Save as... menu options can only be selected if you have entered 
the correct password under Tools / User / Administrator mode. 

3.1.4  Saving a configuration under a different name

The Save as... menu option is used if you want to save the file under a different path or a 
different name. 

NOTE:  The Save and Save as... menu options can only be selected if you have entered 
the correct password under Tools / User / Administrator mode.

1. Open the File menu and click Save as....

2. Enter the name and directory of the configuration file or select a name from the list. 

The file is saved. 

3.2  Exiting BLF-Win 

This menu option is used to exit BLF-Win.

1. Open the File menu and click Exit. 

The applications are closed and BLF-Win Client is terminated. 
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3.3  Editing index cards 

You can create new index cards and you can open, delete or rename existing ones. 

3.3.1  Creating a new index card

1. Open the Edit menu and click New index card... or click the “+” sign at the end of the 
existing index cards.

2. Enter a name for the new index card, for example, customer service.

3. Confirm your entry by clicking OK or click Cancel to create use the default name.

The new index card appears in the display panel, to the right of the existing index cards. 
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3.3.2  Deleting a specific index card 

1. Click the index card to be deleted. 

2. Click Edit / Delete actual index card... in the menu bar or right click on the desired 
index card tab and select “Delete”.

The selected index card is deleted.

3.3.3  Renaming a specific index card...

1. Click the index card that you want to rename. 

2. Click Edit / Rename actual index card... in the menu bar or right click on the desired 
index card tab and select “Rename”. 

3. Enter a new name for the index card. 

4. Confirm your entry by clicking OK.

The index card is renamed.
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3.4  Activating call forwarding

You can use this menu option to activate the call forwarding feature for a selected 
subscriber. 

1. Click Edit / Call forwarding....

The user can select the name of the subscriber whose calls are to be forwarded from a 
list of all available subscribers. 

2. Go to the Forwardable subscribers box and select the station number of the subscriber 
whose calls are to be forwarded. This list contains all numbers, from every connection.

3. Select the ImmediateOn option in the Forward type combo box.

4. Enter the call forwarding destination.

• Enter the number in the VoiceMail box if you want to allow callers to leave you a 
message.

• Use the Destination box to enter the number of the subscriber to which the 
incoming calls should be forwarded.

5. Confirm your entry by clicking OK.

Call forwarding can be activated also by right-clicking on a subscriber and selecting “Call 
forwarding”.

In this case, the Server Name and the Subscriber are automatically selected in the 
drop-down list, and cannot be edited.
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Activating call forwarding
All subsequent calls are automatically forwarded to the specified destination. 

An arrow appears in the display panel field of the subscriber whose calls are to be 
forwarded. 
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3.5  Changing the view in BLF-Win

You can use this drop-down menu to select different views.

The check mark indicates that the function is activated. 

The function is deactivated if no check mark is displayed.

3.5.1  Deactivating the menu bar

You can show or hide the menu bar using the View/Menu option. 

1. Click View/Menu in the menu bar or press the F2 key.

The display of the menu bar in the main window is deactivated. 

3.5.2  Reactivating the menu bar

To reactivate the menu bar, press the F2 key. 

The menu bar reappears in the main window. 

3.5.3  Displaying names

You can use the View / Names menu option to toggle the display of station numbers and 
names. 

Click View / Names in the menu bar to display the check mark or press F7.
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The names are displayed in the main window.

3.5.4  Deactivating the name display

Click View / Names in the menu bar to hide the check mark. 

The station numbers are displayed in the main window instead of the names.

The station number is always displayed if a name is not assigned to a station number.
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3.5.5  Displaying the legend

The legend indicates the colors that are assigned to the ringing states.

You can show or hide the legend using the View / Legend options.

1. Click the Legend option to display the check mark.

The legend is displayed in the main window.

3.5.6  Deactivating the legend display

1. Click the Legend option to hide the check mark.

The legend is not displayed in the main window.

3.5.7  Displaying the absence management

The absence management indicates the free/busy status of the actual selected subscriber.

You can show or hide the absence management using the View/Absence management 
option.

Click View / Absence management option to display the check mark.
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The Absence management is displayed in the lower part of the main window. 

For more information about how to set up the absence management, see Chapter 3, “Using 
the Absence management”.
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3.5.8  Deactivating the absence management

Click View / Absence management option to hide the check mark.

The absence management is not displayed in the main window.

3.5.9  Activating/Deactivating „Always on top“

Click the View / Always on top option to display the check mark.

BLF-Win is then always on the uppermost position of the desktop even if BLF-Win is not 
focused.

To deactivate the function, click on View / Always on top again to hide the check mark.

BLF-Win will then go automatically in the background when another program is in focus.

3.5.10  Displaying canonical numbers

You can show or hide the canonical numbers by selecting the View / Canonical number 
menu option.

Click View / Canonical number in the menu bar to display the check mark. The subscribers 
are displayed as canonical number in the main window.

3.5.11  Hiding canonical numbers

Click View / Canonical number in the menu bar to hide the check mark. The short 
number are displayed in the main window. 
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The view with short numbers is set by default. 

3.5.12  Activating/Deactivating resizable mode

The main window is set to resizable by default. The number of cells in the window depends 
on the cell size and windows size. This mode can be changed only when administrator 
mode is activated (see Chapter 3, “Administrator mode”).

To activate the option, click View / Resizable option to display the check mark. 

The window can be resized by dragging the right lower corner of the window, right to the 
Connection status. 

To deactivate the option, click View / Resizable option again to hide the check mark.

The window size is now fixed.

3.5.13  Defining a prefix

You can define a prefix that is used when adding new subscribers and subscriber ranges 
in the display panel by selecting the Tools menu option. 

1. Click Tools / Options / Prefix... in the menu bar.

2. Enter the Prefix number e.g. +49(1)200-

3. Click OK.

The prefix is stored now. Any new subscriber or subscriber range which doesn’t have a 
prefix in the database will use this prefix. 

3.5.14  Defining colors

You can customize the colors that are used to indicate the various ringing states in the 
display panel by selecting the Tools menu option.
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1. Click Tools / Options / Colors... in the menu bar. A dialog box for editing the status 
colors opens.

2. Click one of the status options, for example, Idle. A dialog box containing the color 
palette appears.

3. Select a color by clicking on it.

4. Click OK. 

The selected status is displayed in the selected color. 
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3.5.15  Cell size

You can use this menu option to change the cell size and width in the display panel. 

1. Click Tools / Options / Cellsize... in the menu bar.

2. Enter a value for the horizontal and vertical size of the cell (the cell size is specified in 
dots).

3. Confirm your entries by clicking OK.

The settings will take effect. 

3.5.16  Font

You can set the font for all existing and future cells using this menu option. 

1. Click Tools / Options / Font... in the menu bar.

2. Select a font, for example, Arial.

3. Click OK. 

The settings will take effect.
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3.5.17  Selecting the language

The display language of the BLF-Win Client can be changed in the Tools / Options menu. 

1. Open Tools / Options / Language 

2. Select the desired language: English, German or Italian are available. A dialog will 
appear confirming the change and warning that the application must be restarted. (the 
dialog is displayed in the selected language). 

3. Click OK and restart the application. 

The application will be displayed in the selected language.

3.6  Log settings

The logging configuration can be changed in the Tools / Options menu. 
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Log settings
1. Open Tools / Options / Log settings 

2. Check Enable logging to allow the creation of log files (BLF.log).

3. Set the File count. This is the maximum number of log files that can be created.

4. Set the File size (MB). This is the maximum size of one log file in MB.

5. 5. Click OK.

6. A message dialog will display that the application must be restarted to apply the 
changes. 
The Log settings are saved. 

NOTE:  The log files are stored in the following path: C:\ProgramData\BLF\Logs\ 
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3.7  User administration

Permission to save files and to change the password is granted using the Tools / User 
menu option. 

3.7.1  Administrator mode

1. Click the Tools / User / Administrator mode option.

2. Enter the password.

The default password is: HIPATH (uppercase letters)

3. Click OK. 

The Save and Save as... menu options are activated in the menu bar under File if the 
password is correct. 

Administrator mode is activated and a check mark   is displayed. 

You can now save current configurations (<configuration name>.blf). All settings 
(colors, index cards, subscribers and subscriber groups) are saved.
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3.7.2  Changing the password 

1. Click the Tools / User / Change password menu options.

2. Enter the old password in the first box. 

3. Enter the new password once in the two other boxes. 

4. Click OK.

The new password is now valid.

3.8  Using the Absence management

1. Click the Tools / Absence management menu options.

2. Select the start time and the end time for the absence information 

3. Select the number of checked days 

4. Enter the refresh time for the synchronization with the Exchange Server 

5. Check or uncheck if the Outlook profile dialog should or should not be displayed when 
the BLF-Client is started 
 A31003-H3231-U100-01-7619, 10/2022
34 BLF-Win 3.0, User manual



Using BLF-Win
6. Select the Outlook Profile.

7. Click Allow if the above dialog comes up.

8. Select a Profile, then click OK.

9. Click OK in the Absence manager dialog.

All absence information is saved and now valid. 

3.8.1  Setting subscriber’s absence information

To set the absence information of a subscriber, edit or create a new subscriber.
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1. Enter an e-mail address, or a name in the Email address field. 

2. Click the Resolve button.

A popup message will indicate if the entered information is valid. 

• If an e-mail address is entered, then its syntax is checked.

• If a name is entered, then the outlook will try to resolve the name’s e-mail address.

3.8.2  Viewing the absence information of a subscriber

To view the absence information of a subscriber, click on a subscriber in the main window.
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NOTE:  To display the absence management, read the Chapter 3, “Displaying the absence 
management”.

NOTE:  To access a contact's calendar data from the Outlook contact list, the contact must 
have a shared calendar.

3.9  Connection to BLF Server

The BLF Client is able to connect to up to 10 BLF servers at the same time.

3.9.1  BLF Server Configuration

When starting the BLF client with empty configuration, the BLF Server configuration will 
show up automatically. The configuration window can be opened also from Tools / BLF 
Server configuration.
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The table contains the following Columns:

• Connected: read-only field which can be True or False, depending on the connection 
status. It will be updated after reopening this window.

• Enabled: mark this check if the connection needs to be established after Ok is pressed.

• IP: the IP address of the CSTA when connecting to iBLF, or the IP address of the BLF 
Server PC. 

• Port: the port of the BLF Server, usually 5050.

• Name: name of BLF Server for easier identification. If no name is specified, then the 
<IP>:<Port> will be used as the server name. 

• Delete: check this if the selected BLF Server needs to be deleted after Ok is pressed.

3.9.2  Enable/Disable SSL Connection

The BLF Client can connect to the BLF Server via SSL or without encryption.

• Activating the SSL encryption: click Tools / Enable SSL connection in the menu bar to 
display the check mark.

• Deactivating the SSL encryption: click Tools / Enable SSL connection in the menu bar 
to hide the check mark.

After changing the connection type, a new dialog alerts that the application must be 
restarted. 
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NOTE:  The connection of BLF Client and iBLF is set to SSL by default. The Windows 
based BLF Server can accept only non-encrypted connections. 

3.10  Obtaining the database 

The BLF Client periodically compares the checksum of the local and remote database and 
retrieves the database from the BLF server if necessary. Furthermore, the database can be 
updated manually from BLF Client, selecting Tools / Request Database.

3.11  Using the Help 

You can obtain information about the version and copyright details of BLF-Win-Client by 
selecting Help / About 

Selecting Help / Contents or pressing F1 provides you information about the operation and 
setting options of BLF-Win. 
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4  Managing BLF-Win

This chapter describes how to create new subscribers and subscriber ranges and how to 
edit or delete existing ones.

4.1  Managing subscribers 

This section describes how to create new subscribers in BLF-Win and how to edit, copy or 
delete existing ones. 

NOTE:  Hunt groups and chief/secretary configurations are not supported. 

4.1.1  Creating a new subscriber

1. Right click on a blank cell and select New subscriber. 

2. Configure the subscriber in the new dialog:
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• Select the Server Name from the drop-down list. This list contains the entries from 
BLF Server configuration (see Chapter 3.9.1, “BLF Server Configuration”).

• Select the Subscriber’s number from the drop-down list or enter the number 
manually. This list contains the subscribers of the selected server, based on the 
database. 

• The Name (optional field) is automatically displayed if a name is assigned to the 
station number in the database. This field can be edited manually. 

• Enter the Email address (optional field) and click resolve if presence information is 
needed (see Chapter 3.8, “Using the Absence management”).

• Enter some text in the Note field (optional field) to have additional information about 
the subscriber. 

• Click on Font button to change the font for this specific subscriber. 

3. Click OK.

The station number or the name of the new subscriber is displayed in the cell, depending 
on the display configuration (see Chapter 3.5.3, “Displaying names”).

4.1.2  Adding multiple subscribers

1. Right click on a blank cell and select Add multiple subscribers.

2. Select the subscribers from the list:

• Select the Server Name from the drop-down list. This list contains the entries from 
BLF Server configuration (see Chapter 3.9.1, “BLF Server Configuration”).
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• Select the desired subscribers in the Select column or click Select all to select all 
subscribers.

3. Click Add.

The subscribers are added into the cells.

The addition direction points downwards from the selected cell to the bottom of the window, 
then continues from the top in the next column while skipping the already occupied cells.

4.1.3  Editing a subscriber

1. Right click on a subscriber and select Edit subscriber. 

2. Follow the steps from step 2 in Chapter 4.1.1, “Creating a new subscriber”. The 
modifications will take effect. 

4.1.4  Deleting a subscriber

Right click on a subscriber and select Delete subscriber. 

The subscriber is deleted from the display panel.

4.2  Managing subscriber ranges

This section describes how to create new subscriber ranges in BLF-Win and how to edit or 
delete existing ones. 
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4.2.1  Creating a new subscriber range

1. Right click on a blank cell and select New subscriber range.


The range requires two adjacent empty cells. If you click on a cell whose adjacent cell 
is occupied, or on the last cell on the right side of the window, the option will not be 
active. 

2. Configure the range in the new dialog. 

• Select the Server Name from the drop-down list. This list contains the entries from 
BLF Server configuration (see Chapter 3.9.1, “BLF Server Configuration”).

• Select the Subscriber’s number from the drop-down list or enter the number 
manually. This list contains the subscribers of the selected server, based on the 
database. The number should be entered without the last digit. 

• Click on Font button to change the font for this specific subscriber range. 

3. Click OK.

The new subscriber range appears in the selected cell. 

4.2.2  Adding multiple subscriber ranges
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1. Right click on a blank cell and select Add multiple subscriber ranges.

The range requires two adjacent empty cells. If you click on a cell whose adjacent cell 
is occupied, or on the last cell on the right side of the window, the option will not be 
active. 

2. Select the subscriber ranges from the list:

• Select the Server Name from the dropdown list. This list contains the entries from 
BLF Server configuration (see Chapter 3.9.1, “BLF Server Configuration”).

• Select the desired subscriber range in the Select column or click Select all to select 
all subscriber ranges. 

3. Click Add.

The subscriber ranges are added into the cells. 

The addition direction points downwards from the selected cell to the bottom of the 
window, then continues from the top in the next column while skipping the single or 
already occupied cells. 
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4.2.3  Editing a subscriber range

1. Position the mouse pointer over a subscriber range.

2. Follow the steps from step 2 in Chapter 4.2.1, “Creating a new subscriber range”.

The modifications will take effect. 

4.2.4  Deleting a subscriber range

Right-click on a subscriber and select Delete subscriber range. 

The subscriber range is deleted from the display panel. 

4.3  Arranging the objects in the display panel 

You can reposition the subscribers and the subscriber ranges in the display panel by using 
a drag-and-drop operation. 

1. Click the object (subscriber or subscriber range) to be moved with the left mouse key. 

2. Drag the object to the required position with the mouse key held down. 

3. Release the mouse button. 

The object has now been shifted to the required position. 

NOTE:  
An object cannot be moved outside of the display panel. 
A subscriber range object can be moved only to two adjacent empty cells.

4.4  DS-Win: retrieving subscriber’s status

The subscriber status from BLF Client can be displayed in DS-Win in a popup box, when 
the subscriber is selected in the DS-Win subscriber table. 
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1. Start DS-Win and open Options / Application settings... then select the BLF-WIN tab.

• Select active.

• BLF window title: the first few letters of the BLF Client window title, which is 
enough to distinguish it from other window titles. 

• BLF-Win number field: the field name used for the extension in the Subscriber 
table.

2. Click Ok to save the changes. 

3. In BLF Client click on Tools / Connect to DS-Win to display the check mark. 

The BLF Client is now connected to DS-Win.
A31003-H3231-U100-01-7619, 10/2022
BLF-Win 3.0, User manual 47



AC-Win: making a call from BLF Client
Example: 

To deactivate the connection of BLF Client with DS-Win, click on Tools / Connect to 
DS-Win to hide the check mark. 

4.5  AC-Win: making a call from BLF Client 

BLF Client is able to initiate a call from AC-Win when a subscriber is selected. 

1. Start AC-Win and make sure it is connected to the OS4K. 

2. In BLF Client click on Tools / Connect to AC-Win to display the check mark. 
The BLF Client is now connected to AC-Win. 

3. In BLF Client double click on a free (idle state) a subscriber. 

The selected subscriber’s number is transferred to AC-Win. The AC-Win window becomes 
focused and the number is dialed. 

4.6  Using BLF-Win in conjunction with Optiset/OptiPoint 

BLF-Win can also be used in conjunction with Optiset/OptiPoint. 
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AC-Win and Optiset/OptiPoint have the same functionality in terms of BLF-Win. Both can 
forward an incoming call to the required extension. 

1. Open Tools / Optiset Extension. 

2. Tick Use Optiset Extension and specify an extension number in the text field.

3. Click OK. The Optiset Extension is saved. 

4. Double click on a free (idle state) a subscriber.

The configured Optiset/Optipoint extension is dialing the selected subscriber. 

NOTE:  Optiset/OptiPoint and AC-Win cannot be operated simultaneously with BLF-Win. If 
the AC-Win connection is also enabled in the Tools menu, then the call will be initiated with 
AC-Win.

Example: 

• The Optiset Extension is configured for 1309 which is the BLF user’s phone.

• An external call is received for 1309. The external caller would like to speak to 
subscriber 1101. BLF-Win indicates that subscriber 1101 is idle. 

• The BLF user double clicks on subscriber 1101. The 1101 rings, the connection status 
changes to Ringing in BLF Client. 

• The connection status changes to Busy as soon as subscriber 1101 answers the call. 

• When the BLF user hangs up the station 1309, the call is forwarded to the external party 
and the connections tatus of 1309 becomes idle again, while the connection status of 
1101 remains Busy while it is connected to the external caller. 

The use of Optiset/OptiPoint or AC-Win allows an incoming call to be forwarded directly to 
the relevant extension. Intermediate steps such as informing the subscriber that he/she has 
received a call or informing the caller that the call is being forwarded are superfluous. 
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